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COMPUTER APPLICATIONS

INTRODUCTION

In previous lesson you have studied about computer, its generations, and how it
performs various tasks. Computer, not only processes data and makes available
information, but it is also able to perform subsequent steps on the basis of processed
information. Computers have changed the way people work. Computers handle
various tasks in business, education, manufacturing, transportation, and other fields.

In this Lesson, we will cover an overview of applications of computers in various
fields, particularly in the field of  libraries.

OBJECTIVES

After completing this lesson, you will be able to :

● list  uses of computers in various fields,

● define word processing and learn its features,

● use Microsoft Office Word 2007,

● explain Internet and its services,

● search Internet to find information, and

● use e-mail to send and receive messages.

Let us begin by learning the use of computers.

2.1 USE OF COMPUTERS

The value of computer lies in its ability to perform certain basic tasks quickly and
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accurately. These tasks include:

● solving numerical problems;

● storing and retrieving information; and

● creating and displaying documents and pictures.

2.1.1 Solving Numerical Problems

A most important and difficult task performed by computers is the solution of
complicated problems involving numbers. Computers can solve such problems at
amazingly high speed. In many cases, solutions show how certain things work,
behave or happen. Scientists and Engineers rely on computers to solve the
complicated sets of equations that they use to make predictions.

In economics and finance, computers solve equations to make predictions about
money. Some of the most widely used computer programs are those which rely on
simple equations. Such programs help people and businesses to work out their taxes,
create budgets, and calculate value of their investments.

2.1.2 Storing and Retrieving Information

People use computers to store large quantities of information. In the context of
libraries, information stored in computers is called a database. Databases can be
enormous, for example, a large library’s entire collection might be contained in a
single database.  A computer can search a huge database quickly to find specific
piece of information. In addition, information can be changed easily and quickly.
The efficiency with which a computer can store and retrieve information makes it
a valuable tool not only in libraries but in a wide range of professions.

2.1.3 Creating and Displaying Documents and Pictures

Computers can store huge quantity of data which can be easily manipulated. Word
processing programs make it easy to change text that has been typed into a computer.
For example, you can quickly correct typing or spelling mistakes. Words, sentences,
and entire sections of a document can be added, removed or changed and printed.
Business people, journalists, scientists, lawyers, secretaries, and students are among
those who benefit from word processing. Computers are also important in the
publishing industry. For example, most books, magazines and newspapers are
typeset by computers. Computer graphics is use of computers to make pictures that
almost look like photographs. Computer graphics are also used to create electronic
video games. Computer programs that perform computer-aided-design (CAD) are
important in many fields, particularly engineering and architecture. Computers can
also produce figures by converting information into pictorial form. For example,
computers enable business people, economists, scientists, and students to plot
graphs, etc. In a technique called computerized tomography, or the CT scan, a
computer uses X-ray data to construct an image of a body part on a screen. Doctors
use these images to diagnose diseases and disorders.

You have observed how computers are useful in various fields. Let us study some
of the computer applications in library.
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2.1.4 Application of Computers in Libraries

Libraries use computers to automate their house keeping operations such as
acquisition, cataloguing, circulation and serials control. Students can search the
computerized catalogue in the library to find books and other resources of the library.
Some college and university libraries maintain their websites, where they upload
and maintain their OPAC (Online Public Access Catalogue). Students and teachers
can utilize this to search books and resources available in the library from anywhere
and at any time using Internet. Students can also reserve a book, make suggestions
for purchase of a book, and renew online the borrowed book from the library. Using
computers, libraries can provide access to electronic publications such as e-journals,
e-databases to which library is subscribing. Many libraries are offering reference
services in online mode, where user can communicate with the librarian from remote
location face-to-face as is done in traditional reference service. Many libraries
provide a list of Frequently Asked Questions (FAQ) and their answers on their
websites, which users can access anytime from anywhere using Internet.

INTEXT QUESTIONS 2.1

Select the correct option

1. Which of the following is a basic task performed by a computer?

a) Making phone calls

b) Searching Internet

c) Playing computer games

d) Storing and retrieving information

2. Which of the following is not an application of computers in librearies?

a) OPAC  b) Access to e journals c) CT Scan d) FAQ

2.2 WORD PROCESSING

Word processing is an Application Software. It is a way of producing documents in
effective and efficient manner. Word processor enables you to create, edit and save
documents for immediate use and store them for future retrieval and reference. You
can edit and give a variety of layout to the document. Word processor helps you to
write letters, memos, reports, articles or even books. Word processors vary
considerably, but most of them support several features as below.

2.2.1 Features of Word Processing

● Create and save a document in a customized templates for future use

● Merge documents

● Efficient Mode of Text Editing: Allows insert or delete text anywhere in the
document.



20 :: Library Application in Libraries

Notes

CERTIFICATE IN LIBRARY AND INFORMATION SCIENCE

● Facility of Cut, Copy and Paste

● Search and Replace Text

● Page Size and Margins: Allows to define various page sizes and margins.

● Word Wrap: Word processor automatically moves to the next line when the
text in the previous line reaches the specified margin. When you change the
margin it will again readjust the text.

● Print: Allows you to print a copy of the document.

● Autocorrect

● Auto format a document

● Create simple tables

● Export documents

There are a large number of word processing software packages available for use.
Some of the commonly used packages are:

● Microsoft Office Word (MS-Word)

● Word Star

● Word Perfect

Word Star and Word Perfect work in DOS environment and MS- Word works in
WINDOWS environment.  Most of the computers use Windows Operating System,
Microsoft Word, which is part of MS-Office, becomes the natural choice for the
users. It is used by maximum number of users worldwide.

INTEXT QUESTIONS 2.2

Sate True or False

1. Word processing is a system software.

2. There is facility to cut, copy and paste text in every word processing package.

3. MS-Word is used by maximum number of users worldwide.

2.3 MICROSOFT OFFICE SYSTEM 2007

MS-WORD is a part of bigger software package, namely MS-OFFICE System.
Microsoft Office System 2007 is a collection of eight most common desktop
programs. Microsoft Office Word 2007 is one of the word processing programs.

2.4 MICROSOFT OFFICE WORD 2007

In order to make use of Microsoft Office Word (MS-Word), you must have a
computer with Windows operating system. The most common way to start Word is
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from the Start menu displayed on the left end of Windows Taskbar.

Click on Start button move the pointer to Programs. On the Programs sub-menu
move the pointer up until Microsoft Office System is highlighted. On the Microsoft
Office System submenu, move the pointer down until Microsoft Office Word 2007
is highlighted, then click on Microsoft Office Word, you will see the Microsoft
Office Word screen.

Fig. 2.1: Dialog box to open Microsoft Word

Fig. 2.2: Word document
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2.4.1 Microsoft Office Word Screen

On the upper left side of the screen is Microsoft Office Button. On the right of
Microsoft Office Button is Quick Access Toolbar. By default this toolbar displays
Save, Undo and Repeat commands. The Title bar displays the name of active
document. It also displays control menu icon on its right hand side corner. Control
menu has Minimize, Maximize, and Close buttons to minimize, maximize and close
the window.

a) Ribbon

Below the title bar is Ribbon, which makes all the capabilities of Word available
in one area. Commands represented as buttons on the tabs make up the Ribbon.
Ribbon has 7 tabs – Home, Insert, Page Layout, References, Mailings, Review
and View. These tabs give access to all the commands available in the Word. On
each tab, buttons are organized into groups. On the right end of the ribbon is Help
button which is indicated by “?”. Using this, you can get on-line-help for any
function.

Home tab is active by default. On Home tab the commands or buttons are organized
into 5 groups viz. Clipboard, Font, Paragraph, Styles, and Editing.

Click the Insert tab and explore its buttons. Buttons related to all the items you
can insert are organized into seven groups: Pages, Tables, Illustrations, Links,
Header & Footer, Text and Symbols.

Click the Page Layout tab and explore its buttons. Buttons related to the appearance
of your document are organized into five groups on this tab: Themes, Page Setup,
Page Background, Paragraph, and Arrange.

Click the References tab and explore its buttons. Buttons related to items you can
add to long documents such as reports, are organized into six groups on this tab:
Table of Contents, Footnotes, Citations & Bibliography, Captions, Index and
Table of Authorities.

Click the Mailings tab and explore its buttons. Buttons related to mass mailings
are organized into five groups on this tab: Create, Start Mail Merge, Write and
Insert Fields, Preview Results and Finish.

Click the Review tab and explore its buttons. Buttons related to proofing,
commenting and changing documents are organized into six groups on this tab:
Proofing, Comments, Tracking, Changes, Compare, and Protect.

Click the View tab and explore its buttons. Buttons related to changing the view
or display of the documents, are organized into five groups on this tab: Document
View, Show/Hide, Zoom, Window, and Macros.

b) Document window

In the document window, you will be typing or inserting the textual or graphical
content of the document. The insertion point is a vertical bar called Cursor. The
document window allows you to work with two documents simultaneously. When
more than one document is open, each document has its own window.
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c) Ruler Bar
It is used to adjust margins and indents of the document.

d) Scroll Bar
It is used to move around the document.

e) Status Bar

This bar displays the information about the active document in which user is
working.

f) To Display a Document in Different Views

In Word, you can view a document in following five different ways:-

● Print Layout view

● Full Screen Reading view
● Web Layout view

● Outline View

● Draft view

To See Different Views of a Document

a) On the View tab, in the Document Views group, click the button for desired
view, or

b) Click a view button on the View Toolbar at the right-hand side of the Status
bar.

g) Zooming the View

The zoom feature of the Word allows you to increase the size of the text to make it
easy to read. The zoom percentage can be set between 10% to 500%.

INTEXT QUESTION 2.3

Fill in the blanks:

1. The Microsoft Office word is a __________

2. __________ is used to move around the document.

3. Ribbon has _____________ tabs.

2.4.2 Working with Word Document

When you first start Word, a new blank document called document window appears
on the screen. The insertion point, the Cursor, keeps on moving towards right while
typing, and once it reaches the right indent, it automatically shifts to the next line.
This feature is called Word Wrap. Enter key is pressed only when you start a new
paragraph.
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2.4.3 Creating a New Document

Click the Microsoft Office Button the commands related to managing documents
such as creating, saving, and printing is available from the menu that opens. This
menu known as the Office menu, takes the place of File menu which appeared in
previous versions of Word. The commands on the left are for tasks related to
document as a whole. After you have worked with a document, its name appears in
the Recent Documents list so that you can open it again quickly. At the bottom of
the Office menu there are buttons for changing program options and for exiting the
Word.

Fig.2.3: Dialog box to pen recent document

1) To Open a New Document

Click on the Microsoft Office Button Click on New and then in the New
Document window, double click Blank Document.

Fig. 2.4 : Dialog box to open a new Word document
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2) To Open an Existing Document

a) Click on the Microsoft Office Button Click on Open

b) Change folder (select your Folder)

c) Click on the file and click on Open button.

3) To Save a Document for the First Time

a) On the Quick Access Toolbar, click the Save button or click Save As on
the Office menu.

b) Navigate to the location where you want to save the file, type a name for
the document in the File name box, and then click Save.

4) To create a New Folder While Saving a Document

a) In the Save As dialog box, click the New Folder button.

b) Type the name of the new folder, press enter key and then click Open.

5) To Print a Document

Three options are available for printing a document namely, Print Preview,
Quick Print and Print.

Fig. 2.5: Dialog box to print a document

To Close a Document

On Office menu click on Close button
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IN-TEXT QUESTIONS 2.4

Match the following :

a) Print layout view (i) Increasing size of text

b) Save button (ii) View tab

c) Zooming (iii) Open an existing document

d) Open button (iv) Saving a document

2.4.4 Editing a Document

While typing from the keyboard, you are likely to make mistakes. Correcting these
mistakes is called Editing.

1) To Delete Selected Text

Press Delete key or Backspace key of the keyboard.

2) To Copy, Cut or Paste selected Text

a) On the Home tab, in the Clipboard groups, click the Copy or Cut button.

b) Click where you want to paste the text, and then in the Clipboard group,
click the Paste button.

Fig. 2.6:Paste button

3) To undo an Action

On the Quick Access Toolbar, click the Undo button.

4) To Find Text

a) On the Home tab, in the Editing group, click the arrow of the Find
button.

b) On the Find tab of Find and Replace dialog box, specify the text you
want to find, and then click Find Next.
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5) To Replace Text

a) On the Home tab, in the Editing group, click the arrow of Replace
button.

b) On the Replace tab of the Find and Replace dialog box, specify the text
you want to find and the text you want to replace it with, and then click
Find Next.

c) Click Replace to the first instance of the text, Replace All to all instances,
or Find Next to leave that instance unchanged and move to the next one.

6) To Check Spelling and Grammar

a) On the Review tab, in the Proofing group, click the Spelling and
Grammar button.

b) In the Spelling and Grammar dialog box, click the appropriate button
to correct the errors Word finds or to add words to the custom dictionary
or AutoCorrect list.

Fig.2.7:Spelling and grammer dialog box

2.4.5 Formatting Documents

The term formatting refers to changes you make in your document’s appearance.

Formatting is an important part of all the documents you prepare. There are three

types of formatting in Word:

● Character Formatting (Application to selected text),

● Paragraph Formatting (Application to entire paragraph), and

● Page Formatting (Application to entire page).
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a) Character Formatting

Here font size and colour of the text can be formatted.

b) Paragraph Formatting

With Paragraph Formatting, Alignment, Indent, Line Spacing and Paragraph spacing

can be set. In Word one can quickly create bulleted and numbered lists to make a

document easier to read and understand. Border and Shading can be applied to a

single paragraph, group of paragraphs or around graphics.

c) Page Formatting

Header and Footer option is used to put repetitive information in the top and bottom

margins of a document. To insert page numbers to your document, click on the Insert

tab Go to Header and Footer group and then, click on the Page Number arrow.

Activity 2.1

1. Create a document of five pages using Microsoft Office Word. Select a
paragraph in the document, change its background to blue and put a border
around the paragraph.

INTEXT QUESTIONS  2.5

Name the following:

1. Three types of formatting in word

2. To undo an action.

3. To Replace text.

2.4.6 Using MS-WORD Help

● To find out about any item on the screen you can display a Screen Tip. For
example, to display Screen Tip for a button, point to the button without clicking
it. The Screen Tip gives the button’s name, the associated shortcuts if there is
one, and a description of the associated action.

● You can click the Help button in the upper-right corner of the program window
to display the Help window.

● If your computer is connected to the Internet, information is available from
Microsoft Office Online. (http://www.microsoft.com/msprss/ support/
search.asp)

In the subsequent sections you will study about Internet and its various services.
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2.5 INTERNET

Internet is a worldwide system of interconnected computer networks to serve billions
of users worldwide. Internet is a global data communication system. It is a hardware
and software infrastructure that provides connectivity among computers. It is a
network of networks that consists of millions of private, public, academic, business,
and government networks of local to global scope that are linked by a broad arrays
of electronic and optical networking technologies.

The Internet provides a wide range of information services. Most popular are the
interlinked hypertext documents of World Wide Web (WWW) and Electronic Mail
services. Using Internet, you can communicate with your friends and search
information you require for your study, research or for entertainment. You can even
do online shopping, reserve airline tickets and many more things.

Internet was originally created in 1960s for US government’s military tasks and it
was named ARPANET. Its commercialization started in 1990s. The Internet has no
centralized governance in either technological implementation or policies for access
and usage. Each individual network sets its own standards. However, to maintain
interoperability, two principle name spaces in the Internet, namely, the Internet
Protocol (IP) address space and Domain Name System (DNS) are administered by
Internet Corporation for Assigned Names and Numbers (ICANN), headquartered
in Marina Del Ray, California, USA.

For safe movement of data, there are set of rules, which govern sending and receiving
of data on the Internet. These rules are implemented in two parts in the network
software and are called Transmission Control Protocol (TCP) and Internet Protocol
(IP). These two are collectively called TCP/IP. The IP in TCP/IP is a mechanism
for providing unique addresses for computers on the Internet.

Common method of Internet access in home includes dial-up, landline broadband,
Wi-Fi, satellite, and 3 G/4G technology cell phones. Public places to use the Internet
are Cyber café, airport halls and coffee shops, where you can access internet by
paying charges.

2.5.1 Services of Internet

● World Wide Web

● E-mail

● Cloud computing

2.5.1.1  World Wide Web (WWW)

World Wide Web, also called Web, is a collection of Web sites on the Internet. A
Web site has collection of web pages linked to one another to form a global ‘web’
of information. Web pages present information on variety of topics. These pages
may include text, images, sounds and even video clips. All these pages are linked
to each other or even to section within a Web page. These links are known as Hyper
Links. All this information is presented in very attractive and entertaining way.
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The WWW offers information on any topic you want. Whatever the topic, the Web
always has some Web sites on that topic. The Web is a source of information for
companies, business houses, educational institutions, government departments and
even individuals. The Web gives you the latest news of any event in any corner of
the world. Often news is available on it before that is broadcast by any other media.
Many educational institutions in India and abroad put useful information on the
Web, such as their activities, courses offered, fee, and other details. You can do
online shopping, play games, watch movies, listen to music, and many more things
on the web.

a) Web Browser

The software required to access and view any information on the Web is known as
Internet browser or Web browser. Microsoft Internet Explorer and Google Chrome
are the most popular Web browsers. The process of using browser to view
information on the Internet is known as Browsing or Surfing.

b) Web Server

It is a large computer that stores one or more Web sites. When you want some
information on the Internet, Web server ‘serves’ you the relevant Web pages on your
computer.

c) URL (Uniform Resource Locater)

The address of a Web site on the Internet is known as URL. To access any Web site
on the Internet you have to know its address. For example URL of NIOS is:-

http://www.nios.ac.in

Let us see, what each item in this address stands for

1. Protocol: Most Web addresses begin with http:// (Hyper Text Transmission
Protocol). This protocol (procedure) transmits web pages from the Web server
to your computer. The letters http are always followed by a colon and two
forward slashes (//).

2. Web: WWW stands for World Wide Web. Web addresses have www after http:/
.

3. Host: This is the name of the Web site. In this example nios is the name of the
host.

4. Type of site: This part of the Web address tells you the type of site, a particular
web site is. In present case .ac stands for academic site and .in stands for India.

There are other types of sites also, such as:-

com : commercial organizations .

gov: government organizations

net: network organizations .

edu: educational institutions .
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mil: military organizations.

org: organization other than commercial or Educational. It is non-profit
organisation

5. Domain Name: The host and the type of site, together is called domain name.
In this case domain name is nios.ac.in.

● Searching the web

There are billions of pages stored on the Web and it is very difficult to find right
information you want. Nevertheless, the web has some special search tools that help
you to search exact information quickly and easily. These tools are known as Web
search engines. A search engine is a site on the WWW, with the help of which you
can search for other websites. It searches on the basis of keywords that you give. It
matches your information (keywords) to the web pages listed in its index and then
displays only those sites that are relevant and match your keywords.

There are many web search engines available. They can be grouped depending on
how they work. For example, if you are looking for a job, you need to use job search
engine like www.monster.com. If you want to shop online, then you need to use
www.shopzilla.com or www.flipcart.com. There are over 2500 search services
available on the Internet. Two most popular search engines are www.google.com
and www.yahoo.com.

To search, get connected to Internet. Then Log on to www.google.com. Google
search screen appears. In the text box type in the Keyword(s) you want to search.
For example, you want to search for “open schools in India”, type that in the
keywords. Press the enter key or click on Google Search to see the results. The search
results display all the results in the form of hyperlinks. These are all the websites.
Click on the hyperlink of your choice for the information you want.

Fig. 2.8: Search results for open school in India
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Activity 2.2:

1. Log on to the Internet. Search the National Institute of Open Schooling(NIOS)
and list the type of courses offered by the NIOS.

INTEXT QUESTIONS 2.6

Fill in the blanks:

1. Example of  web browsers is ____________.

2. www is acronym for ___________

3. The address of a website on the Internet is known as __________.

2.5.1.2  Electronic Mail

Electronic mail, commonly known as e-mail, is a method of sending digital
messages, notes or letters from one person to another or to many people at the same
time via Internet. E-mail is faster and less expensive as compared to normal postal
services. You can also attach a file, graphics, images or even video along with the
messages. E-mail is the fastest and the most economical way of sending messages
to a number of people across different countries.

There are a number of web sites providing free e-mail services. Some of them are
Gmail.com, Yahoo.com, Hotmail.com, Rediffmail.com, etc. You have to register
with them to use their e-mail service.

E-mail Address

When you register with any of the sites providing e-mail services, you are given an
e-mail Id which you can use to send and receive the messages. The E-mail Id is like
an address, which provides all the information required to get a message to the
recipient from anywhere in the world. Consider the following e-mail ID.

saroj@yahoo.com or sunita@gmail.com

In the above examples, “saroj” and “sunita” are the names of users and Yahoo and
Gmail are names of two mail servers called Host, .com specifies the type of site. In
this case .com stands for commercial site. The host and type of site together is called
domain name. The user name is always followed by the ampersand symbol @
(pronounced at). It separates the user name from the rest of the e-mail address. Any
e-mail messages sent to you are first stored on your mail server. When you want to
read an e-mail, you have to receive it from the mail server to your computer. For
this, you have to log on to your mail server. After logging on, you have to fill in
your e-mail ID and the password. Your mail box opens and you can receive and
send e-mail messages to your friends.  (Fig. 2.10)
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Fig.2.10: Dialogue box for e-mail account

2.5.1.3: Cloud Computing

Cloud computing is an umbrella term used to refer to Internet based development
and services. It is a new class of network based computing that takes place over the
Internet. Here, the word cloud is used as a metaphor for “the Internet,” so the phrase
cloud computing means “a type of Internet-based computing,” where different
services — such as servers, storage and applications — are delivered to an
organization’s computers and devices through the Internet.

Here the users  can put their data on the platform instead of on their own desktop
PCs and/or on their own servers. They can also put their applications on the cloud
and use the servers within the cloud to do processing and data manipulations etc.

Advantages of cloud computing are:

● Lower computer costs

● Improved performance

● Reduced software costs

● Unlimited storage capacity

●  Universal document access
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Disadvantages of Cloud Computing are:

● Requires a constant Internet connection

● Does not work well with low-speed connections

● Can be slow

● Stored data might not be secure

● Stored data can be lost

Many of the activities loosely grouped together under cloud computing have already
been happening and centralised computing activity is not a new phenomena. Well
known examples of cloud computing  are Amazon’s Elastic Compute Cloud (EC2)
and Simple Storage Solution (S3).

INTEXT QUESTION 2.7

Fill in the blanks:

1. Electronic mail is commonly known as _________.

2. The user name in  an e-mail address sunita@gmail.com is _________.

3. In Cloud Computing, the users  can put their data on the _________ instead of
on their own desktop PCs and/or on their own servers.

Activity 2.2

1. Log on to the Internet. Search the National Institute of Open Schooling (NIOS)
website and list the type of courses offered by the NIOS.

WHAT YOU HAVE LEARNT

● The efficiency with which computer store and retrieve information makes it a
valuable tool in a wide range of fields.

● Computers applications have a valuable role in  libraries.

● Word processing is an application software that helps to create, edit and save
documents.

● MS-word is the most popular word processing program.

● Internet is a global data communication system that provides connectivity
among computers.

● Internet and its services, i.e., world wide web (www) and e-mal are very
popular.
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● The internet services make available a variety of information and enable new
forms of social interaction.

TERMINAL EXERCISE:

1. Write an essay on computer and its impact on our day-to-day life.

2. Describe in brief the applications of computers in various fields.

3. Discuss in brief the Internet and its services like World Wide Web and E-mail.

ANSWERS TO INTEXT QUESTIONS

2.1

1. (d)

2. (c)

2.2

1. False

2. True

2. True

2.3

1. Word Processing Program

2. Scroll Bar

3. Seven

2.4

a)    (ii)

b)    (iv)

c)     (i)

d)  (iii)

2.5

1. Character, Paragraph and Page Formatting

2. Undo Button

3. Replace Button
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2.6

1. Microsoft Internet Explorer, Google chrome etc

2. World Wide Web

3. URL

2.7

1. E-mail

2. Sunita

3. Platform

TERMS:

The terms covered in this lesson which require further explanation are given  below
in an alphabetic order. The learner is required to explain each term.

Button:

Cursor:

Dialog box:

E-mail:

Group:

Host:

HTML:

Hyperlink:

Icon:

Internet:

Log on:

Mail box:

Mail Server:

Menu:

Network:

Online:

Ribbon:

Tab:


